Chapter 1

Introduction to
Autodesk Revit 2023
for Architecture

Learning Objectives

After completing this chapter, you will be able to:

* Understand the basic concepts and principles of Revit 2023 for Architecture
* Understand different terms used in Revit

* Know the parametric behavior of Revit

* Start the Revit 2023 program

* Use different components of the User interface screen of Revit

* Access the Revit 2023 Help

* Know worksharing using Revit Server

* Know about Autodesk Construction Cloud
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INTRODUCTION

Welcome to the realm of Revit, a powerful building modeler that has changed the outlook
of the building industry about computer aided designs. Autodesk Revit is a design and
documentation platform that enables you to use a single, integrated building information
model to conceptualize, design, and finally document a project. Its integrated parametric
modeling technology is used to create the information model of a project, and to collect and
coordinate information across all its representations. In Autodesk Revit, drawing sheets, 2D
views, 3D views, and schedules are a direct representation of the same building information
model. Using its parametric change engine, you can modify a design at any stage of a project.
The change in the project is automatically made and represented in all its views, resulting in the
development of better designs, along with an improved coordination. The use of Revit provides a
competitive advantage and a higher profitability to architects and building industry professionals.

Autodesk Revit AS A BUILDING INFORMATION MODELER

The history of computer aided design and documentation dates back to the early 1980s
when architects began using this technology for documenting their projects. Realizing its
advantages, information sharing capabilities were developed, especially to share data with
other consultants. This led to the development of object-based CAD systems in the early 1990s.
Before the development of these systems, objects such as walls, doors, windows were stored
as a non-graphical data with the assigned graphics. These systems arranged the information
logically, but were unable to optimize its usage in a building project. Realizing the advantages
of the solid modeling tools, the mechanical and manufacturing industry professionals began
using the information modeling CAD technology. This technology enabled them to extract data
based on the relationship between model elements.

In 1997, a group of mechanical CAD technologists began working on a new software for
the building industry. The Building Information Modeling (BIM) provided an alternative
approach to building design, construction, and management. This approach, however,
required a suitable technology to implement and reap its benefits. In such a situation, the use of
parametric technology with the Building Information Modeling approach was envisaged as an
ideal combination. They developed a software that was suitable for creating building projects.
This software was earlier known as Autodesk Revit Architecture, and has now been changed to
Autodesk Revit.

Autodesk Revit is a building design and documentation platform in which a digital building
model is created using the parametric elements such as walls, doors, windows, and so on. All
the building elements have inherent relationship with one another, which can be tracked,
managed, and maintained by the computer.
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BASIC CONCEPTS AND PRINCIPLES

Autodesk Revit enables you to envisage and develop a building model with actual 3D
parametric building elements. It provides a new approach to the architectural thought and
the implementation process. In a way, it replicates the way architects conceive a building. For
example, 2D CAD platforms mostly use lines to represent all elements, as shown in Figure 1-1.
However, in Autodesk Revit, you can create a building model using 3D elements such as walls,

floors, doors, and windows, as shown in Figure 1-2.
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Figure 1-1 CAD project created using 2D lines and curves
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Figure 1-2 Autodesk Revit project created using parametric building model

Using these 3D elements, you can visualize the architectural or interior project with respect
to its scale, volume, and proportions. This enables you to study design alternatives and
develop superior quality design solutions. Autodesk Revit automates routine drafting and
coordination tasks and assists in reducing errors in documentation. This, in turn, saves time,

improves the speed of documentation, and lowers the cost for users.
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Understanding the Parametric Building Modeling Technology
A project in Autodesk Revit is created using the in-built parametric building elements. The
term parametric refers to the relationship parameters between various building elements. Some
relations are applied automatically to building elements while creating them, and some are user
defined. For example, doors, which have an inherent parametric relationship with walls cannot
be created without first creating a host wall. A door always moves with the host wall. Similarly,
floors too are parametrically linked to walls. When you move walls, the floor extents are also
modified automatically. Each building element has in-built bidirectional associativity with many
other elements in the project.

A building information model is created using different interdependent parametric building
elements such as walls, floors, roof, ceiling, stairs, ramps, curtain walls, and so on. As they are
bidirectionally associated elements, any change made in one element is automatically adopted
by others. The integrated building information model thus created contains all the data for a
project. You can then create project presentation views such as plans, sections, elevations, and
so on for documentation. As you modify the model while working in certain views, Autodesk
Revit’s parametric change engine automatically updates other views. This capability is, therefore,
the underlying concept in Autodesk Revit.

Autodesk Revit’s parametric change engine enables you to modify design elements at any stage
of the project development. As changes are made immediately and automatically, it saves the
time and effort in coordinating them in all other associated views which for most projects is an
inevitable part of the design process. Revit’s capability to coordinate between various aspects of
the building design provides immense flexibility in the design and development process along
with an error-free documentation.

Revit also provides a variety of in-built parametric element libraries that can be selected and
used to create a building model. It also provides you with the flexibility of modifying properties
of these elements or create your own parametric elements based on the project requirement.

Terms Used in Autodesk Revit

Before using Revit, it is important to understand the basic terms used for creating a building
model. Various terms in Revit such as project, level, category, family, type, and instance are
described next.

Autodesk Revit Project

A project in Revit is similar to an actual architectural or interior project. In an actual project,
the entire documentation such as drawings, 3D views, specifications, schedules, cost estimates,
and so on are inherently linked and read together. Similarly, in Revit, a project not only includes
the digital 3D building model but also its parametrically associated documentation. Thus, all
the components such as the building model, its standard views, architectural drawings, and
schedules combine together to form a complete project. A project file contains all the project
information such as building elements used in a project, drawing sheets, schedules, cost estimates,
3D views, renderings, walkthroughs, and so on. A project file also stores various settings such as
environment, lighting, and so on. As data is stored in the same file, it becomes easier for Revit
to coordinate the entire database.
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Levels in a Building Model

In Autodesk Revit, a building model is divided into different levels. These levels may be
understood as infinite horizontal planes that act as hosts for different elements such as roof, floor,
ceiling, and so on. The defined levels in a building model in most cases relate to different floor
levels, or stories of the building project. Each element that you create belongs to a particular level.

Subdivisions of Elements into Categories and Subcategories

Apart from building elements, an Autodesk Revit project also contains other associated elements
such as annotations, imported files, links, and so on. These elements have been divided into
following categories:

Model Category : Consists of various building elements used in creating a building
model such as wall, floor, ceiling, roof, door, window, furniture,
stairs, curtain systems, ramps, and so on

Annotation Category : Consists of annotations such as dimensions, text notes, tags, symbols,
and so on

Datum Category : Consists of datums such as levels, grids, reference planes, and so
on

View Category : Consists of interactive project views such as floor plans, ceiling
plans, elevations, sections, 3D views, renderings, and
walkthroughs

In addition to these four categories, other categories such as Imported, Workset, Filter, and
Revit Categories can also exist if the project has imported files, enabled worksets, or linked
Revit projects, respectively.

Families in Autodesk Revit

Another powerful concept in Autodesk Revit is family. Family in Revit is described as a set
of elements of the same category that can be grouped together based on certain common
parameters or characteristics. Elements of the same family may have different properties, but
they all have common characteristics. For example, Double Hung is a single window family,
but it contains different sizes of double hung windows. Family files have a .7fa extension. You
can load additional building component families from the libraries provided in Revit package.

Families are further divided into certain types. Type or family type, as it is called, is a specific
size or style of a family. For example, Double Hung: 36" x 48” is a window type. All uses of the
same family type in a project have same properties. Family and family types can also be used to
create new families using the Family Editor.

Instances are the actual usage of model elements in a building model or annotations in a
drawing sheet. A family type created in a new location is identified as an instance of the family
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type. All instances of the same family type have same properties. Therefore, when you modify
the properties of a family type, the properties of all its instances also get modified. The family
categorization of Revit elements is given below:

Model Category : Wall

Family : Basic Wall

Family type : Brick on Mtl. Studs

Instance : Particular usage of a family type

The hierarchy of building elements in Revit plays an important role in providing the flexibility
and ease of managing a change in the building model. Figure 1-3 shows the hierarchy of
categories and families in a typical Revit project. The following is another example of the terms
described in this section.

Autodesk Revit Elements

Model Category  Annotation Category =~ Datum Category View Category
Walls Dimensions Grids Floor plans
Floors Text Notes Levels Ceiling plans|
Roofs Tags Reference Planes Elevations
Ceilings Symbols Sections
Doors Keynotes 3D Views
Windows Callout views
Stairs Walkthroughs

Figure 1-3 Hierarchy of Autodesk Revit categories and families

Creating a Building Model Using Parametric Building Elements
Another classification of categories of elements followed in Revit is based on their usage. Revit
uses five classes of elements: host, component, annotation, view, and datum. Hosts are the element
categories that form the basic structure of a building model and include model elements such
as walls, floor, roof, and ceiling. Components are the elements that are added to host elements
or act as stand-alone elements such as doors, windows, and furniture. Annotations are the 2D,
view-specific elements that add content to the project documentation such as dimensions, tags,
text notes, and so on. Views represent various orientations of a building model such as plans,
elevations, sections, 3D views, and so on. Datum refers to the reference elements that assist you
in creating a building model, which include grids, levels, reference planes, and so on.

There is no specific methodology available for creating a building model in Revit. It provides
you with the flexibility of generating building geometry based on the project requirement,
design complexity, and other factors. However, the following steps describe a general procedure
that may be followed for creating an architectural building model using the in-built parametric
elements provided in Revit.

The first step is to create the exterior walls of a building at the predefined lowest level (level 1).
Next, create interior walls at that level and add components to the building model. Then, define
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the upper levels based on the story height of the building. You can also link the control height
of the walls to the levels and extend the exterior walls to their full height. Next, create floors
and roof using the defined levels. Add the site topography to the building model and then add
site components to complete the building project. You can then create drawing sheets with the
desired views for its presentation. Revit also provides tools to create rendered 3D views and
walkthroughs. Figure 1-4 shows an example of a building section with various building elements
and annotations.
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Figure 1-4 Buwilding section showing building elements and levels

Visibility/Graphics Overrides, Scale, and Detail Level

Revit enables you to control the display and graphic representation of a single element or
the element category of various elements in project views by using the visibility and graphics
overrides tools. You can select a model category and modify its linetype and detail level. This
can also be done for various annotation category elements and imported files. These settings
can be done for each project view based on its desired representation. You can also hide an
element or an element category in a view using the Hide in View and Isolate tools. You can
override the graphic representation of an element or an element category in any view using
the Visibility/ Graphics tool.

The scale is another important concept in a Revit project. You can set the scale for each project
view by selecting it from the available list of standard scales such as 1/16”=1°0", 1/4”"=1'0",



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

1-8 Exploring Autodesk Revit 2023 for Architecture

17=1°0", 1/2”=1"0”, and so on (for imperial). As you set a scale, Revit automatically sets the
detail level appropriate for it. There are three detail levels provided in an Revit project: Coarse,
Medium, and Fine. You can also set the detail level manually for each project view. Each detail
level has an associated linetype and the detail lines associated with it. The details of annotations
such as dimensions, tags, and so on are also defined by the selected scale.

Extracting the Project Information

Assingle integrated building information is used to create and represent a building project. You
can extract project information from a building model and create area schemes, schedule, and
cost estimates, and then add them to the project presentation.

Revit also enables you to export the extracted database to the industry standard Open Database
Connectivity (ODBC) compliant relational database tables. The use of the building information
model to extract database information eliminates the error-prone method of measuring building
spaces individually.

Creating an Architectural Drawing Set

After creating the building model, you can easily arrange the project views by plotting them on
drawing sheets. Drawing sheets can also be organized in a project file based on the established
CAD standards followed by the firm. In this manner, the project documentation can easily be
transformed from the conceptual design stage to the design development stage and finally to the
construction document stage. The project view on a drawing sheet is only a graphical representation
of the building information model and therefore, any modification in it is immediately made in
all the associated project views, keeping the drawings set always updated.

Creating an Unusual Building Geometry

Revit also helps you conceptualize a building project in terms of its volume, shape, and
proportions before working with the actual building elements. This is possible by using the
Massing tool, which enables you to create quick 3D models of buildings and conduct volumetric
and proportion study on overall masses. It also enables you to visualize and create an unusual
building geometry. The same massing model can then be converted into a building model with
individual parametric building elements. It provides continuity in the generation of building
model right from sketch design to its development.

Flexibility of Creating Special Elements

Revit provides a large number of in-built family types of various model elements and annotations.
Each parametric element has the associated properties that can be modified based on the project
requirement.

Revit also enables you to create the elements that are designed specifically for a particular location.
The in-built family editor enables you to create new elements using family templates. This
provides you with the flexibility of using in-built elements for creating your own elements. For
example, using the furniture template, you can create a reception desk that is suitable for a
particular location in the design.
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Creating Structural Layouts

Revit’s structural tools enable you to add structural elements to a building model. An extensive
in-built library of structural elements has been provided in Revit. You can add structural columns,
beams, walls, braces, and so on to the project. Thus, structural consultants can also incorporate
their elements in the basic architectural building model and check for inconsistency, if any.

Working on Large Projects

In Revit, you can work on large projects by linking different building projects together. For
a large project that consists of a number of buildings, you can create individual buildings as
separate projects and then link all of them into a single base file. The database recognizes the
linked projects and includes them in the project representation of the base file.

For example, while working on a large campus of an educational institution, you can create
separate project files for academic building, administration area, gymnasium, cafeteria, computer
centre, and so on, and then link them into the base site plan file. In this manner, large projects
can be subdivided and worked upon simultaneously.

Working in Large Teams and Coordinating with Consultants
Worksets in Revit enable the division of the building model into small editable set of elements.
The worksets can be assigned to different teams working on the same project and then their
work can easily be coordinated in the central file location. The effort required to coordinate,
collaborate, and communicate the changes between various worksets is taken care of by computer.
Various consultants working on a project can be assigned a workset with a set of editable elements.
They can then incorporate their services and modify the associated elements.

For example, a high rise commercial building project can be divided into different worksets
with independent teams working on exterior skin, interior walls, building core, toilet details,
finishes, and so on. The structural consultants can be assigned the exterior skin and the core
workset in which they can incorporate structural elements. Similarly, the rest of the teams can
work independently on different worksets.

STARTING Autodesk Revit 2023

You can start Autodesk Revit 2023 by double-clicking on its shortcut icon located on
the desktop. Alternatively, you can start Autodesk Revit 2023 from the taskbar. To
do so, choose the Start button; a menu is displayed. Choose Autodesk > Revit 2023, as shown
in Figure 1-5; the interface screen will be displayed, as shown in Figure 1-6.
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Figure 1-5 Starting Revit 2023 from the taskbar

Note
@ The path for starting Revit depends on the operating system being used.

The Revit interface screen has two sections: Models, and Families. The options in the Models
section are used to open an existing model, a new model, and an existing template. The options
in the Families section are used to open a new or an existing family. You can also invoke the
Conceptual Mass environment from this section to create a conceptual mass model.
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Figure 1-6 The interface of Autodesk Revit 2023

In the interface screen you can choose the What’s New? option to get information about the
new tools and features in Revit 2023.

When you click on the What’s New? option, you are directed to the Autodesk Revit 2023 page
that has a list of videos of newly added features in Revit. You can click on a link to view the
corresponding video.

You can choose the Autodesk App Store option from the InfoCenter to access various add-ons
that can be used to enhance the productivity of Revit. On choosing this option, the Autodesk
App Store page will be displayed. In this page, various links are available as add-ons which can
be used in Revit applications. In the Revit Community option of the InfoCenter section, you
can access information related to various communities and their contribution in the form of
articles, tutorials, and videos.

In addition, you can choose the Help option from the InfoCenter to get help on various tools.
When you choose this option, you will be directed to https://help.autodesk.com/view/RV1/2023/
ENUY/. Also, the Autodesk Revit 2023 page with the Welcome to Revit 2023 Learning area
will be displayed. To access information related to additions and enhancements in Revit 2023
release, you can expand the What’s New node from the left pane and then click on the What’s
New link. On doing so, the What’s New page will be displayed with various links. You can visit
the links to learn about enhancements in Revit 2023.

The new interface screen of Autodesk Revit 2023 has been enhanced to provide better experience
for navigating BIM 360 projects. Now, you can access your projects stored in BIM 360 directly
from the interface screen of Revit 2023 by clicking on the Autodesk Docs button.
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Some other features are also available in the interface screen of Autodesk Revit 2023. These
include Community Forum and Customer Support options. When you click on the Community
Forum option, Revit 2023 directs you to https://forums.autodesk.com/t5/revit-products/ct-p/2003 page.
On this page, you can access Autodesk’s Revit Forums to share your knowledge, ask questions,
collaborate on ideas, and explore popular Revit topics. When you click on the Customer Support
option, you are directed to hitps://knowledge.autodesk.com/contact-support page. This page provides
you the information on purchasing, downloading, installing and troubleshooting of various
softwares. This page also assists you in managing your Autodesk account and your software license.

In the Models section, choose the Open option; the Open dialog box will be displayed. Browse
to the desired location in the dialog box and select the file. Now, choose the Open button to
open the file.

To open a new model file, choose the New option from the Models section. Alternatively, choose
New > Project from the File menu; the New Project dialog box will be displayed. In this dialog
box, you can select the desired template from the Template file drop-down list or you can browse
the other template files by using the Browse button from the Template File area. When you
choose the Browse button, the Choose Template dialog box will be displayed. In this dialog box,
make sure the Project radio button is selected, and then choose the OK button; a new project
file will open and the interface screen will be activated.

USER INTERFACE

Autodesk Revit has ribbon interface. The ribbon which contains task-based tabs and panels,
streamlines the architectural workflow and optimizes the project delivery time. In Revit, when
you select an element in the drawing area, the ribbon displays a contextual tab that comprises
of tools corresponding to the selected element. The interface of Autodesk Revit is similar to
the interfaces of many other Microsoft Windows based programs. The main parts in the Revit
interface are Ribbon, Options Bar, Project Browser, Drawing Area, Status Bar, and View
Control Bar, as shown in Figure 1-7.
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Figure 1-7 The Autodesk Revit 2023user interface screen
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Invoking Tools
To perform an operation, you can invoke the required tools by using any one of the following
two options:

Ribbon: You can invoke all necessary tools from the ribbon.

Shortcut Keys: Some tools can also be invoked by using the keys on the keyboard.

Title Bar

The Title bar, docked on the top portion of the user interface, displays the program’s
logo, program’s name of the current project, and the view opened in the viewing area.
Project 1- Floor Plan: Level 1 is the default project and view.

Ribbon

The ribbon, as shown in Figure 1-8, is an interface that is used to invoke tools. When you open a
file, the ribbon is displayed at the top in the screen. It comprises of task-based tabs and panels,
refer to Figure 1-8, which provide all the tools necessary for creating a project. The tabs and
panels in the ribbon can be customized according to the need of the user. This can be done by
moving the panels and changing the view states of the ribbon (changing the ribbon view state is
discussed later in this chapter). The ribbon contains buttons, drop-downs, panels, tabs, and tools.
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Presentation Graphics. N Create Sheet Composition

Button Panel Tab Drop-down

Figure 1-8 Different components of a ribbon

Moving the Panels

In the ribbon, you can move a panel and place it anywhere on the screen. To do so, press and
hold the left mouse button on the panel label in the ribbon and drag it to some desired place
on the screen. Next, use the tools of the

moved panel and place the panel back to /';,\q.u gl% ‘%’ 21& J_L

E?etum Panels to Ribbon

the ribbon. To do so, place the cursor on By Shaft Wall Vertical Dormer
the moved panel and choose the Return Face
Panels to Ribbon button from the upper Opening

right corner of this panel, as shown in
Figure 1-9; the panel will return to the
ribbon.

Figure 1-9 Choosing the Return Panels to Ribbon
button

Changing the View States of the Ribbon

The ribbon can be displayed in three view states by selecting any of the following four options:
Minimize to Tabs, Minimize to Panel Titles, Minimize to Panel Buttons, and Cycle through
All To use these options, move the cursor and place it over the second arrow on the right of
the Modify tab, refer to Figure 1-10 in the ribbon; the arrow will be highlighted. Now, click
on the down arrow; a flyout will be displayed, as shown in Figure 1-10. In this flyout, you can
choose the Minimize to Tabs option to display only the tabs in the ribbon. If you choose the

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



Evaluation Copy. Do not reproduce. For information visit www.cadcim.com

1-14 Exploring Autodesk Revit 2023 for Architecture

Minimize to Panel Titles option, the ribbon will display the titles of the panels along with the
tabs. You can choose the Minimize to Panel Buttons option to display the panels as buttons in
the ribbon along with tabs.

Massing & Site Collaborate  View Manage Add-lns  Modify (9]

EHEBE B OO AL e

Minimize to Panel Titles

Floor Curtain Curtain Mullion  Railing Ramp Stair Model Model L
T System  Grid - Text Line G binimizejiclanallButions Area -
Circulation Model Cycle through All

Figure 1-10 larious options in the flyout for changing the view state of the ribbon

Tip
Q Tooltips appear when you rest the cursor over any of the tool icons in the ribbon. The name of
the tool appears in the box helping you to identify each tool icon.

Note

@ If the view state of the ribbon is changed, place the cursor over the first arrow at the right of the
Modify tab, the Show Full Ribbon tooltip will be displayed. Click on the arrow; full ribbon will
be displayed.

The following table describes various tabs in the ribbon and their functions:

Tab Description

Architecture Contains tools for creating architectural elements for a
project

Structure Contains tools for creating structural elements in a project

Steel Contains tools for creating steel structure and their
connections details in a project

Precast Contains tools to create precast assemblies and drawings

Systems Contains tools for creating mechanical elements in a project

Insert Contains tools to insert, link, and manage secondary files

such as raster image files, CAD files or PDFs

Annotate Contains tools for documenting a building model such as
adding texts and dimensions

Analyze Contains tools for energy analysis of the project

Massing & Site Contains tools for modeling and modifying conceptual mass

and site elements

Collaborate Contains tools for collaborating the project with other team
members (internal and external)
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View Contains tools used for managing and modifying the current
view and also for switching views

Manage Contains tools for specifying the project and system parameters and
project settings

Add-Ins Contains all the installed Add- Ins (Plug-Ins)

Modify Contains tools for editing elements in the model

Contextual Tabs in the Ribbon

These tabs are displayed based on the tool or the element selected. These tabs contain a set of
tools or buttons that relate only to a particular tool or element. For example, when you invoke
the Window tool, the Modify | Place Window contextual tab is displayed. This tab shows ten
panels: Select, Properties, View, Measure, Geometry, Clipboard, Create, Modify, and Mode.
The Select panel contains the Modify tool. The Properties panel contains the Properties button
and the Type Properties tool. The Mode panel has some necessary tools that are used to load
model families or to create the model of a window in a drawing. The other panels, apart from
those discussed above, contain the tools that are contextual and are used to edit elements when
they are placed in a drawing or selected from a drawing for modification.

File Menu

This menu is displayed on choosing the File button from the ribbon, refer to Figure 1-11. It
contains tools that provide access to many common file actions such as Open, Close, and Save.
You can also invoke this menu by using the keyboard shortcut ALT+F.

BEcHG «-2-2R R e-F9A €

Architecture ~ Structure  Steel  Precast  Systemns  Insert

E| &) Recent Documents
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E L 4 Defense Staff_vptype2.nt
Rec_Slab Edge.rfa
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E’ Save As » Profilel.rfa

default.rte

=) Export 3 Wier.rfa
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Figure 1-11 The File menu
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Quick Access Toolbar
The Quick Access Toolbar, as shown in Figure 1-12, contains the options to undo and redo
changes, open and save a file, create a new file, and so on.

By default, the Quick Access Toolbar contains the following options: Open, Save, Redo, Undo,
and others. You can customize the display of the Quick Access Toolbar by adding more tools
and removing the unwanted tools. To add a tool or a button from the panel of the ribbon to the
Quick Access Toolbar, place the cursor over the button; the button will be highlighted. Next,
right-click; a flyout will be displayed. Choose the Add to Quick Access Toolbar from the flyout
displayed; the highlighted button will be added to Quick Access Toolbar. The Quick Access
Toolbar can be customized to re-order the tools displayed in it. To do so, choose the down arrow
next to the Switch Windows drop-down, refer to Figure 1-12; a flyout will be displayed. Choose
the Customize Quick Access Toolbar option located at the bottom of the flyout; the Customize
Quick Access Toolbar dialog box will be displayed. Use various options in this dialog box and
choose the OK button; the Customize Quick Access Toolbar dialog box will close and the tools
in the Quick Access Toolbar will be re-ordered.

&H"‘.’:”ﬁvw' B'\uf'\E@A @"Q.:E @G,PEI"';

Open _ L L Undo Text J Switch Windows drop-down
Save Synchronize and Modify  -Default 3D View drop-down

Settings
Figure 1-12 The Quick Access Toolbar

InfoCenter

You can use the InfoCenter to search the information related to Revit Help, display the
Communication Center panel for subscription services and product updates, and display
the Favorites panel to access saved topics. Also in the InfoCenter, you can use the Autodesk
Account and the Autodesk App Store options to log-in to Autodesk and Autodesk Exchange
Apps pages. Figure 1-13 displays various tools in the InfoCenter.

b | Tvpe a keyword or phrase HB R shamtickoo52..~ W ® *

‘ Search J | | | L‘_‘

Search Field Autodesk Account Help

Autodesk App Store

Figure 1-13 The InfoCenter
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Status Bar

The Status Bar is located at the bottom of the interface screen. When the cursor is placed
over an element or component, the Status Bar displays the name of the family and type of the
corresponding element or components. It also displays prompts and messages to help you use
the selected tools.

View Control Bar

The View Control Bar is located at the lower left corner of the drawing window, as shown in
Figure 1-14. It can be used to access various view-related tools. The Scale button shows the scale
of the current view. You can choose this button to display a flyout that contains standard drawing
scales. From this flyout, you can then select the scale for the current view. The Detail Level
button is used to set the detail level of a view. You can select the required detail level as Coarse,
Medium, and Fine. Similarly, the Visual Style button enables you to set the display style. The
options for setting the display style are: Wireframe, Hidden Line, Shaded, Consistent Colors,
Realistic, and Raytrace.

Show Crop Region

Visual Style
Detail Level Unlocked 3D View
f Highli
ghlight
Scale —‘ Jj [gDisplacement
= Sets
:uﬂ. L 1|_U'l % d I;l |:r':| 1

Sun Path Of
T’C o5 7 s WT
Shadows Off LTemporary View

Temporary F’roper‘ties

Rendering dialog Hide/lsolate
Reveal Hidden
Crop View Elements

Figure 1-14 The View Control Bar

Options Bar

The Options Bar provides information about the common parameters of component type
and the options for creating or editing of building elements. The Options Bar changes its
appearance based on the type of component selected or being created. You can also modify
the properties of the component by entering a new value in the edit box for the corresponding
parameter in the Options Bar. For example, the Options Bar for the Wall tool displays various
options to create a wall, as shown in Figure 1-15.

Modify | Place Wall | Heigh v Uncon v Location Line: Wall Centerlin v | [Z]chain Offset| € 0 | [JRadiuss 1° 0" Join Status; Allow v
Figure 1-15 The Options Bar with different options to create a wall

Type Selector

The Type Selector drop-down list is located in the Properties palette of the currently invoked
tool. For example, if you invoke the Wall tool, all the properties of the wall will be displayed in
the Properties palette. In the Properties palette, you can use the Type Selector drop-down list
to select the required type of the wall. The options in the Type Selector drop-down list keep on
changing based on the current function of the tool or the elements selected. When you place
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an element or a component in a drawing, you can use the Type Selector drop-down list to
specify the type of element or component. You can also use this drop-down list to change the
existing type of a selected element to a different type. In Revit, you can add the Type Selector
drop-down list to the Quick Access Toolbar. To do so, right-click on the down arrow on the
right in the Type Selector drop-down list in the Properties palette; a flyout will be displayed.
Choose the Add to Quick Access Toolbar option from the flyout.

Drawing Area

The Drawing Area is the actual modeling area where you can create and view the building model.
It covers the major portion of the interface screen. You can draw various building components in
this area using the pointing device. The position of the pointing device is represented by the
cursor. The Drawing Area also has the standard Microsoft Windows functions and buttons such
as close, minimize, maximize, scroll bar, and so on. These buttons have the same function as
that of the other Microsoft Windows-based programs.

Project Browser

The Project Browser is located below the ribbon. It displays project views, schedules, sheets,
families, and groups in a logical, tree-like structure, as shown in Figure 1-16, and helps you open
and manage them. To open a view, double-click on the name of the view; the corresponding view
will be displayed in the drawing area. You can close the Project Browser or dock it anywhere
in the drawing area.

Project Browser - Technical_school-current_m.rvt x
= :D: Views (all) -
=} Floor Plans

T 01 - Entry Level
il_Ii 07 - Entry Level - Furniture Layout
02 - Floor
03 - Floor
il Roof
T site
= Ceiling Plans
T 01 - Entry Level
02 - Floor
03 - Floor

03 - Floor Public - Night Rendering
Balcony View
Building Courtyard
From Parking Area
Cieo
[=-- Elevaticns (Building Elevaticn)
[Ij} Courtyard Elevation - South Wing
T East

Figure 1-16 The Project Browser

/ Note

@ If the Project Browser is not displayed on the screen, choose the View tab from the ribbon and
then click on the User Interface drop-down from the Windows panel. Next, select the Project
Browser check box from the flyout displayed.

The Project Browser can be organized to group the views and sheets based on the project
requirement. For example, while working on a large project with a number of sheets, you can
organize the Project Browser to view and access specific sheets.
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Note

In the Project Browser, you can expand or collapse the view listing by selecting the ‘+’ or =’ sign,
respectively. The current view in the drawing window is highlighted in bold letters. The default
project file has a set of preloaded views.

Keyboard Accelerators

In Revit, accelerator keys have been assigned to some of the frequently used tools. These keys are
shortcuts that you can type through the keyboard to invoke the corresponding tool. Accelerator
keys corresponding to a tool appear as a tooltip when you move the cursor over the tool. In
Revit 2023, you can export all commands (even if they do not have shortcut keys assigned) to
a XML file. You can further edit the XML file to assign shortcut keys to commands, and then
import them back to be used in Revit.

Tip
Q As you get accustomed to using Revit, you will find these Keyboard Accelerators quite useful
because they save the effort of browsing through the menus.

Properties Palette Properties X

The Properties palette, as shown in Type-Selector
Figure 1-17, is a modeless interface, which E-:ll Floor Plan “. drop-down
displays the type and element properties of : list

various elements and views in a drawing.

The Properties palette is dockable and  FloorPlan: Level 1

o e
v Edit Type Edit Type

resizable, and it supports multiple monitor  Graphics A » button

configurations. The Properties palette is View Scale 1/8" = 1-0"

displayed in the Revit interface by default Scale Value 1:196

and it shows the instance properties of an Display Model :Normal

active view. When you select an element from Detail Level  :Coarse

a drawing, the Properties palette displays Parts Visibility :Show Original

its instance properties. You can also access Visibility/Grap.. Edit..

the Type Properties of the selected element Graphic Displ... Edit... | [nstance
. : - - Properties

from the Properties palette. To do so, Orientation Project North

choose the Edit Type button from the Wall Join Disp...:Clean all wall j...

palette; the Type Properties dialog box will Discipline Architectural

be displayed. In this dialog box, you can
change the Type Properties of the selected
element. In the Properties palette, you can

Figure 1-17 The Properties palette

assign a type to a selected element in a drawing from the Type Selector drop-down list. In Revit,
you can toggle the display of the Properties palette in its interface. Choose the Properties button
in the Properties panel of the Modify tab to hide it. Similarly, you can choose the Properties
button to display the palette if it is not visible in the interface.

DIALOG BOXES

Some Revit tools when invoked display a dialog box. A dialog box is a convenient method of
accessing and modifying the parameters related to that tool. For example, when you choose
Save As > Project from the File menu, the Save As dialog box will be displayed, as shown in
Figure 1-18. A dialog box consists of various parts such as dialog label, radio buttons, text or
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edit boxes, check boxes, slider bars, image box, and tool buttons, which are similar to other
windows-based programs. Some dialog boxes contain the [...] button. On choosing such buttons,
another related dialog box will be displayed. There are certain buttons such as OK, Cancel, and
Help, which appear at the bottom of most of the dialog boxes. The names of the buttons imply
their respective functions. The button with a dark border is the default button.
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Mame . Date modified Type Size
EArch Link Model.rt 01-02-2022 15:27 Autodesk Revit Pr... 15,240 KB
E BIM_Projekt_Golden_Nugget-Architektur_u..,  30-01-2022 15:24 Autodesk Revit Pr... 1,259,448 KB
BIM_Projekt_Golden_Nugget-Gebaeudetech... 30-01-2022 15:24 Autodesk Revit Pr... 91,904 KB
rac_advanced_sample_project.nt 01-02-2022 15:27 Autodesk Revit Pr... 16,544 KB
E rac_basic_sample_project.rit 28-01-2022 15:26 Autodesk Revit Pr... 18,400 KB
E rme_advanced_sample_project.nt 01-02-2022 15:27 Autodesk Revit Pr... 36,183 KB
E rme_basic_sample_project.nt 01-02-2022 15:27 Autodesk Revit Pr... 30,056 KB
E rst_advanced_sample_project.nvt 01-02-2022 15:27 Autodesk Revit Pr... 14,068 KB
E rst_basic_sample_project.nit 28-01-2022 13:26 Autodesk Revit Pr... 6,300 KB
ETechnica\_school-current_m.rvt 01-02-2022 15:27 Autodesk Revit Pr... 16,060 KB
@t EE 14-01-2022 15:27 Autodesk Revit Pr... 64,128 KB
Eh‘);")bﬁiﬁm 21-01-2022 15:26 Autodesk Revit Pr... 48,3500 KB
Eﬁ);")béﬁfﬁm 21-01-2022 15:26 Autodesk Revit Pr... 87,208 KB
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Files of type: |Project Files (*.rvt) ~ Options...
Tools - Save Cancel

Figure 1-18 The Save As dialog box

MULTIPLE DOCUMENT ENVIRONMENT

The multiple document environment feature allows you to open more than one project at a
time in a single Revit session. This is very useful when you want to work on different projects
simultaneously and make changes with reference to each other.

Sometimes you may need to incorporate certain features E ] O]
from one project into the other. With the help of 2 E -
multiple document environments, you can open switch | Close  Tab  Tile
multiple projects and then use the Cut, Copy, and JWindows | inactive Views Views

Paste tools from the Clipboard panel of the Modify Velimten ik - Heer o Sl

(type of element) tab to transfer the required 2 c08_office_tut4 - Floor Plan: Roof
components from one project to another. These 3 c08_office_tut4 - Floor Plan: Ground Floor
editing tools can also be invoked by using the 4 c08_office_tut4 - Elevation: West
CTRL+C and CTRL+V keyboard shortcuts. 5 c08_office_tut4 - Floor Plan: First Floor

To access the opened projects, choose the Switch
Windows drop-down from the Windows panel of
the View tab; a menu will be displayed showing the
name of different project files opened, as shown in
Figure 1-19. Like other Microsoft Windows-based programs, you can select and view the opened
projects using the Tile and Tab tools from the Windows panel of the View tab. Figure 1-20
shows the tab view of projects.

Figure 1-19 Selecting an option from
the Switch Windows drop-down
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Figure 1-20 The Tab view of the projects

INTEROPERABILITY OF Autodesk Revit

The models or geometries created in Revit can easily be exported to AutoCAD based programs,
such as 3ds Max and Max Design in the DWG file format. This enables you to visualize and create
photorealistic exterior and interior renderings for your project designs. You can also transfer
drawings from Revit to Trimble SketchUp to visualize your projects in a better way.

Revit follows a wide range of industry standards and supports various CAD file formats such as
DWG, DXF, DWE, DGN, FBX, and SAT. For image files, it supports JPG, TIFF, BMP, PNG, AVI,
PAN, IVR, and TGA file formats. Besides these, the formats that are supported by Revit include
ODBC, HTML, TXT, gbXML, XLS, and MDB. Revit is compatible with any CAD system that
supports the DWG, DXF, or DGN file format. Revit can import the models and geometries as
ACIS solids. This enables designers to import models from AutoCAD Architecture and AutoCAD
MEP (Mechanical, Electrical, and Plumbing) software and to link and import 3D information to
Revit. This feature makes Revit an efficient, user-friendly, and compatible software.

In Revit, you can directly link the files into 3ds Max and load selected views in it. You can also
override material in 3ds Max and retain its settings when you reload Revit link file. Also, in 3ds
Max, you can add high level of details to the curved objects to make them smooth. Microstation
is interoperable with Revit. Therefore, the Microstation files can be imported to the Revit project.
In addition to this, mapping functionality for levels, lines, line weights, patterns, and texts and
fonts is added to export DGN workflow.

Revit provides fully certified IFC (Industry Foundation Class) import and export based on
buildingSMART® IFC data exchange standards. For importing IFC files Revit supports IFC files
based on the following buildingSMART International (bSI) data exchange standards: IFC2x3,
IFC2x2, and IFC2x. For import (link only), Revit also supports IFC files based on the bSI IFC4
standard.
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For export, Revit supports the following standards: IFC4, IFC2x3, and IFC2x2. When you
export a Revit building information model to IFC format, the information can be used directly
by other stakeholders, such as structural and building services engineers. For example, if a
building information models is created in Revit and saved as .rv¢ file format, you can export
the building model using the IFC format to an IFC-certified application such as Tekla, Open
Building and others file format. The exported model can be opened and worked on in the non-
native application. Similarly, in Revit you can import an IFC file, create a RVT file, and work
on the building model in Revit.

IFC file uses architecturally meaningful data to describe real-world building objects. These data
include parameters that have meaningful values. In Revit 2023, the standard Revit elements
have corresponding IFC scheme. These do not require any specific user action to export them.
(For example, Revit walls export as ifcWalls.) Other Revit families (such as escalators) require
that you map them to IFC scheme before exporting

BUILDING INFORMATION MODELING AND Autodesk
Revit

Building Information Modeling (BIM) is defined as a design technology that involves creation and
use of coordinated, internally consistent, and computable information about a building project
in design and construction. BIM covers spatial relationships, geographic information, quantities,
and properties of building components. Using this technology, you can demonstrate the entire
life cycle of a building project starting from the process of construction, facility operation, and
information about quantities and shared properties of elements. BIM enables the circulation of
virtual information model from the design team to contractors and then to the owner, thereby
adding changes and their knowledge to update the model at each stage of transfer. The ability to
keep information up-to-date and make it available in an integrated digital environment enables
the architects, owners, builders, and engineers to have clear vision of the project before the
commencement of actual construction. It enables them to make better and faster decisions as
well as to improve the quality and profitability of projects. Autodesk Revit is a specially designed
platform based on BIM. Revit is the best example of the BIM technology. Revit’s parametric model
represents a building as an integrated database of coordinated information. In Revit, change
anywhere is change everywhere. Any change made in your project at any stage is reflected in
the entire project, and also, due to the parametric behavior of elements, the project is updated
automatically according to the changes made anywhere in the project. Also, the integration of
Revit with the available in-built commercial tools such as solar studies, material takeofts, greatly
simplifies the project design and reduces the time consumed by these analyses, thereby enabling
faster decision making.

Autodesk Revit 2023 HELP

Autodesk Revit provides help to easily understand various tools and methods used in it. In
Autodesk Revit 2023, you can access online help documentation. To access the help feature,
click on the down arrow on the right of the InfoCenter; a flyout will be displayed. Next, choose
the Help option, as shown in Figure 1-21. Various options to access the help are discussed next.
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Using the Revit 2023 Help

You can access Autodesk Revit 2023 help when you are online. To do so, choose the Help tool
from the InfoCenter; the Autodesk Revit 2023 page will be displayed, as shown in Figure 1-22.
In this page, there are several tabs that contain information of help topics. These tabs are useful
to understand the basic concepts of Revit.
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Figure 1-22 The Revit Help page

WORKSHARING USING REVIT SERVER

Worksharing is a method of distributing work among team involved in a project, and
accomplishing it within the stipulated period of time. In worksharing, each person involved in
the project is assigned a task that has to be accomplished by proper planning and by coordinating
with the other members of the team.

In a large scale building project, worksharing helps in finishing a project in time and meeting
the quality requirements that are set during the process. Generally, in a large scale building
project, worksharing is based on the specialization of work. The professionals such as structural
engineers, architects, interior architects, and MEP engineers are involved in their respective
fields to accomplish the project. So, the distribution of work at the primary stage is made on
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the basis of the area of specialization. Each professional has his own set of work to perform for
the accomplishment of the project.

You can apply server-based worksharing with the help of Revit Server as it is a server based
application. Revit Server uses a central server and multiple local servers for collaborating across
a Wide Area Network (WAN). The central server hosts the central model of a workshared project
and remain accessible to all the team members over the Wide Area Network. Similarly, the local
server is accessible to all team members in a Local Area Network (LAN). The local server hosts
alocal updated copy of the central model. In the Worksharing environment, the team members
are not aware of the local server, as it is transparent in their daily operations. Refer to Figure 1-23
for the network model of Revit Server.
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Figure 1-23 The network model of Revit Server

In Worksharing environment, a team member starts working on the local model of the central
model. The local model will be saved in the computer of the team member. As the team member
works, the local server requests updated information from the central model on the central server
using available network capacity to transfer the data over the WAN. The updated version of the
model is stored on the local server, so the updates are readily available when a team member
requests them.



Introduction to Autodesk Revit 2023 for Architecture 1-25

AUTODESK CONSTRUCTION CLOUD

Autodesk Construction Cloud™ is used as a cloud-based construction management and
collaboration solution developed by Autodesk. Autodesk Construction Cloud solution connects
building data, project work flows, and project teams throughout the entire building life cycle,
from design to operations. Autodesk Construction Cloud is built on a integrated platform and
common data environment that will empower general contractors, specialty trades, designers
and owners to drive better business outcomes. Using the Autodesk Construction Cloud solution,
project teams will now have a comprehensive construction management platform in which all
data will be located centrally. As such, it will simplify collaboration, predict project changes,
and will provide guidance that will be driven by data for improvement of the organization. The
Autodesk Construction Cloud offers three main products namely Autodesk Build, Autodesk
Quantity, and Autodesk BIM Collaborate. As part of the unified Autodesk Construction Cloud,
every product is reinforced by Autodesk Docs, Insights, and Administration.

Autodesk Docs cloud platform supports the common data environment for every product of
Autodesk Construction Cloud. It provides the users with uninterrupted navigation of data across
the project teams and throughout the project workflow. Autodesk Docs is a single, cloud-based
platform for streamlining document management by storing and managing all project documents
and data from design through construction in a single platform.

Insights platform is used to delivers analytical report from the data collected and analyzed
from the project. It is also used to export that data to the user with the application of artificial

intelligence to identify and mitigate risk.

Administration platform is used for administrating the data in the project for better practices.

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1. In Revit, you can access offline help only. (T/F)
2. You cannot import 3ds Max file into Revit. (T/F)
3. You can do parametric modeling in Revit. (1/F)

4. You can control the display of the elements in Revit. (T/F)
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Answers to Self-Evaluation Test
1.F,2.F,3.T,4.T



